
FRF

Users Manual

Version: 1.0

Thank you!

Thank you very much for your investment in our unique data acquisition systems. These are top-quality instruments
which are designed to provide you years of reliable service. This guide has been prepared to help you get the most

from your investment, starting from the day you take it out of the box, and extending for years into the future.
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Notice

1 Notice
The information contained in this document is subject to change without notice.

CAUTION Dewesoft GmbH. shall not be liable for any errors contained in this document.
Dewesoft MAKES NO WARRANTIES OF ANY KIND WITH REGARD TO THIS 
DOCUMENT, WHETHER EXPRESS OR IMPLIED.
DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
Dewesoft shall not be liable for any direct, indirect, special, incidental, or consequential 
damages, whether based on contract, tort, or any other legal theory, in connection with the 
furnishing of this document or the use of the information in this document.

Warranty Information:

A copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can be obtained from 
your local sales and service office.
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FRF  

Printing History:

Version  Revision 310
Released 2013
Last changed: 29. May 2014  13:13

Copyright

Copyright © 2011-2013 Dewesoft GmbH

This document contains information which is protected by copyright. All rights are reserved. Reproduction, adaptation, 
or translation without prior written permission is prohibited, except as allowed under the copyright laws.

All trademarks and registered trademarks are acknowledged to be the property of their owners.

1.1 Safety instructions

Your safety is our primary concern! Please be safe!

Safety symbols in the manual

WARNING
Calls attention to a procedure, practice, or condition that could cause body injury or 
death.

CAUTION
Calls attention to a procedure, practice, or condition that could possibly cause 
damage to equipment or permanent loss of data.

General Safety Instructions

WARNING The following general safety precautions must be observed during all phases of operation, 
service, and repair of this product.  Failure to comply with these precautions or with specific 
warnings elsewhere in this manual violates safety standards of design, manufacture, and 
intended use of the product. Dewesoft GmbH assumes no liability for the customer’s failure to
comply with these requirements.
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1.2 About this document
This is the Users Manual for FRF Version 1.0.

1.3 Legend
The following symbols and formats will be used throughout the document.

IMPORTANT
Gives you an important information about a subject.
Please read carefully!

HINT

Gives you a hint or provides additional information about a subject.

EXAMPLE

Gives you an example to a specific subject.
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Introduction

2 Introduction

2.1 FRF module
The DEWESoft™ FRF module is used for analysis of e.g. mechanical structures or electrical systems to determine the 
transfer characteristic (amplitude and phase) over a certain frequency range. 

With the small, handy form factor of the DEWESoft instruments (DEWE-43, SIRIUSi) it is also a smart portable 
solution for technical consultants coping with failure detection.

The FRF module is included in the DSA package (along with other modules e.g. Ordertracking, Torsional vibration, …).

Let's assume there is a mechanical structure to be analyzed. Where are the resonances? Which frequencies can be 
problematic and should be avoided? How to measure that and what about the quality of the measurement?

Probably the easiest way is exciting the structure using a modal hammer (force input) and acceleration sensors for the 
measurement of the response (acceleration output). At first the structure is graphically defined in the geometry editor. 
Then the points for excitation and response are selected. The test person knocks on the test points while the software 
collects the data. Next to extracting phase and amplitude, in Analyse mode it is possible to animate the structure for the 
frequencies of interest. The coherence acts as a measure for the quality. The modal circle provides higher frequency 
precision and the damping factor.

For more advanced analysis the data can be exported to several file formats, important is the widely used UFF to read 
data in e.g. MEScope.

2.2 LTI systems
At first we have to assume that the methods described here apply to LTI (linear, time-invariant) systems or systems 
which come close to that. LTI systems, from applied mathematics, which appear in a lot of technical areas, have 
following characteristics:

Linearity: the relationship between input and output is a linear map (scaled and summed functions at the input 
will also exist at the output, but with different scaling factors)

Time-invariant: whether an input is applied to the system now or any time later, it will be identical

Furthermore, the fundemental giving of evidence in LTI theory is that the system can be characterized entirely by a 
single function called system’s impulse response. The output of the system is a convolution of the input to the system 
with the system’s impulse response.

2.3 Frequency response function
Transfer functions are widely used in the analysis of systems, the main types are

mechanical → excite the structure with a modal hammer or shaker (measure force), measure response with 
accelerometers (acceleration)

electrical → apply a voltage to the circuit on the input, measure back the voltage on the output

In mechanical structures for example, when the transfer characteristic is known, this will show dangerous resonances. 
The frequency range, where the stress to the material is too high, has to be avoided, e.g. by specifying a limited 
operating range. The simplified process works like that: an input signal is applied to the system and the output signal is 
measured. The division of response to excitation basically gives the  transfer function.
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FRF  

In time-domain this is described in the following way:

Laplace transformation leads to the result in frequency domain:

DEWESoft utilizes the widely used H1(f) calculation method, which is applied, when the output is expected to be noisy 
compared to the input.

2.4 System overview
In most of the cases acceleration sensors, microphones, modal hammers or other force transducers are used for analog 
input. If they are e.g. voltage or ICP type, they are connected to the SIRIUS ACC amplifier, or DEWE-43 with MSI-
ACC adapter. When analog output is needed (shaker), the AO8 option (8 channels BNC on rear side of SIRIUS 
instrument) provides a full-grown arbitrary function generator.
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2.5 Enabling FRF module
Like many additional mathematics modules also “Modal Test (FRF, NMT)” is an option to the standard 
DEWESoft™ package and needs to be enabled in the Hardware setup: Enter <Settings> <Hardware Setup> and then 
<Math>.

Usually this must not be done manually, since the license is already stored on your Dewesoft instrument.

Just click on the “Auto Detect” button and all options will be detected and enabled automatically.

2.6 Adding FRF module
In the next step we add one new module with the + button:

The description of the channel setup and the parameters is split into chapters 3.1 Triggered and 3.2 Free-run (sweep) on 
the following pages.

Doc-Version: 1.0 Page 7/49

         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™

        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation   

www.chinaksi.com

http://www.dewesoft.com/


Setup / Operation modes

3 Setup / Operation modes
Depending on the application DEWESoft offers basically two different types of setup:

Triggered: For excitation an impulse is used (=wide frequency spectrum), e.g. modal hammer; easy to setup

Free-run: The structure is excited e.g. with a shaker (or the engine rpm is varied), which sweeps through the 
frequencies (e.g. 10...1000 Hz)

As the channel setup is different, both setup types will be explained seperately, along with practical examples.

3.1 Triggered
The easiest test consists of the modal hammer, which is used for exciting the structure with a short impulse (= wide 
frequency spectrum) and an acceleration sensor measuring the response. The hammer has a force sensor integrated in 
the tip, the tip ends are interchangeable. For bigger structures there are big hammers available with more mass to 
generate a distinct amplitude.

  

HINT
Please keep in mind that a hard tip generates a wider excitation spectrum, therefore you will get 
a better result (coherence) for the higher frequencies.

The two pictures below show the comparison. The scopes on top show time-domain, FFTs below show frequency-
domain (same scaling).

          

hard tip (low damping)   soft tip (high damping)

On the other side, with a hard tip double-hits appear more frequently.
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When you have set the calculation type to “Triggered (FRF)”, the setup looks like shown below.

On the left side specify the excitation (modal hammer), on the right side the response(s) (acceleration sensor(s)). For the
following examples we named the two analog channels “exc” and “resp”.

Let's do a short measurement to explain all the parameters. The structure is hit once and the signals are measured.

The hammer signal (upper, blue line) shows a clean shock impact with about 2500 N peak and high damping, while the 
response (lower, red line) starts ringing and smoothly fades out.
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Trigger level

The FRF module needs a start criteria in triggered mode, therefore we specify a trigger level of e.g. 2000 N. Each time 
the input signal overshoots the trigger level, the FRF calculation (FFT window) will start.

Double hit level

However, when the input signal shows multiple impulses after one hit (so called “double hit”), DEWESoft can identify 
this if you specify a double hit level. When the signal crosses the double-hit-level shortly after the trigger event, you 
will get a warning message and can repeat this point.

Overload level

You can also enable, that a warning will be displayed, if the hammer impact is exceeding a certain overload level (when 
the hit was too strong).

The following picture summarizes the different trigger level options.

Now that we defined the trigger condition, we should ensure that the FRF calculation covers our whole signal to get a 
good result.
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Window length

Let's assume the sample rate of our example is 10 000 Hz and we have adjusted 8192 lines in the FRF setup.

According to Nyquist we can only measure up to half of the sample rate (5000 Hz), or the other way round, we need at 
least 2 samples per frequency line. So, our frequency resolution is:

Df = 10 000 Hz / (8192 lines x 2) = 0,61 Hz.

The whole FFT window calculation time (window length) is

t = 1 / Df = 1 / 0,61 = 1,638 s.

To see the section which is used for FRF calculation, add a 2D graph...

… then add the two channels “exc/Data History” and “resp/Data History”.

Below you see the cut out data section of excitation and response signal, which covers pretty much the whole signal.

Note, that the x-axis is scaled in samples (from -819 to 15565, which gives total 16 384 samples).

16 384 samples * (1/10 000 Hz) = 1,63 s.
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Pretrigger

The pretrigger time is set to default by 5%. From the screenshot above you can see that 5% of 16 384 samples is 819 
samples, which equals t pre = 819 * (1/10 000 Hz) = 81,9 ms. At sample 0 the trigger occurs.

Excitation window length

You can seperately adjust the window length of excitation and response (it's like cutting out the interesting segments of 
the graph above) in order to reduce influence of noise appearing after the event of interest.

The “excitation window length” setting is valid for the excitation signal (modal hammer hit). Per default 100% is 
selected, all of the acquired data will be taken for calculation (all 16 384 samples in our example, the whole shown 
range).

The excitation FFT is of rectangular window type.

In our case the damping is very high (signal fades out quickly), therefore we can select a smaller portion of the signal, 
e.g. 10 % (usually you would define a noise level first to determine it).

The rest of the signal will be cut out completely.

Response window decay

The response FFT is of exponential window type. When the response signal is fading out slowly (low damping), the 
user can specify a certain time after which the signal is faded to zero (exponential decay function). This helps to reduce 
noise at low amplitudes and shortens the measurement time. The draft below gives a rough idea about the damping.
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Averaging of hits

The result can be improved by averaging the excitation and response spectra over a number of impacts. Therefore the 
first e.g. 5 hits will be recognized and taken into calculation, then you move on to the next point.

After explaining all parameters, we will now look at the different operation modes.
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Setup / Operation modes

3.1.1 Triggered, 1 point

When all acceleration sensors are mounted, the structure is excited in one point by the modal hammer (average over a 
number of hits can also be done of course).
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3.1.2 Triggered, roving hammer

1 Exc, 1 Resp

In this operation mode there is one acceleration sensor mounted on a fix position on the structure. The modal hammer is
moving through the points (e.g. doing 5 hits in each point, which are averaged).

This is the easiest test and requires only one hammer and one sensor. 
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1 Exc, Group Resp

Again, the hammer is moving. Multiple acceleration sensors are mounted on fix positions. They are defined by the same
Group name inside DEWESoft (red rectangle).

With the first hammer hit, the transfer functions of the 3 single responses of group A (4Z+, 5Z+, 6Z+) against 1Z+ will 
be calculated: 4Z+/1Z+, 5Z+/1Z+, 6Z+/1Z+.

All resulting transfer functions can be seen in the channel list below:

The red warning (only one exc. Vs multiple response or vice versa is allowed) means that the measurement will be 
performed by manually switching from one excitation point to the next (SIMO = single input multiple output). It's not 
possible to excite all points (1, 2, 3) synchronous and determine the transfer functions.
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3.1.3 Triggered, roving acceleration sensor

The hammer is always exciting the structure at the same position. Now the acceleration sensor is moved to different 
positions. The disadvantage of this setup is, that the mass of the acceleration sensor changes the structure differently in 
every point, therefore influences the measurement (this effect is called “mass loading”). Also between each 
measurement the sensor has to be mounted again, which results in a lot of work.
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3.2 Free-run (sweep)
When doing a frequency sweep and measuring the responses, you have the advantage that the coherence will be much 
better over the whole frequency range compared with a triggered setup. Of course you are facing a more extensive setup
in terms of hardware, you'll probably need a shaker (and a shaker controller, which keeps the amplitude constant over 
the frequency range).

The ODS (operational deflection shapes) is a very special form of FRF, using only accelerometers, please see page 24, 
chapter 3.2.4 ODS.

The channel setup of a typical free-run FRF is shown below.

The FFT windowing section is similar to triggered FRF, therefore please refer to window length section on page 9, 
chapter 3.1 Triggered. You should ensure that the sweep is slowly enough, because the FFT needs some time for 
calculation (number of lines, resolution).

Again, on the left we have the excitation and on the right side response channels.

If you enable the “Use function generator” checkbox, the FGEN settings Waveform, Start freq and Stop freq and the 
“AO channel” column in the excitation section will also be visible. These settings are the same as in the Analog out 
section (function generator).

Furthermore you can adjust here the sweep time and amplitude/phase settings, if you enter the Setup of the according 
channel (AO 1 in our example). On the right side you can tick the checkbox “Show info channels”, e.g. seeing the 
current frequency during sweep is very helpful.
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When you switch to Measure mode or press the Store button, the sweep will start.

In comparison with the triggered measurement our excitation(s) and response(s) will in most of the cases consist now of
sine waves, with distinct amplitude and phase shift.

When using a sine sweep, as the sweep moves through the frequencies, the bode plots will be updated. Putting the 
“AO/Freq” channel on a seperate display is a good way to show the current frequency.

The picture above shows two 2D graph instruments with transfer functions 2-1 and 3-1 (amplitude on top and the phase 
below) during a sweep. The left side is already calculated, while the right side is ongoing.

Now after all parameters have been explained, we will take a look at the different operation modes.
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3.2.1 Free-run (shaker externally controlled)

The usual application for the free-run option is on a shaker. If the shaker is externally controlled, we can measure back 
the excitation signal (with a force sensor) and use it as reference.

Of course it would also be possible to use an engine instead of the shaker, and analyze the transfer functions during 
runup or coastdown.
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3.2.2 Free run, FGEN, shaker

If we tick „Use function generator“, the FRF module accesses the FGEN section (requires Analog output option on 
Dewesoft instrument (AO)). It generates now e.g. a sine sweep from 10 to 1000 Hz. The shaker controller guarantees a 
defined amplitude over all frequencies. With the force sensor we measure back the excitation force.

Please consider that DEWESoft will not do the shaker control (control loop for amplitude), because of speed 
limitations. Practically a shaker control device (“shaker control” box in above picture) will be used in between.
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Setup / Operation modes

3.2.3 Free run, FGEN, multiple shakers

There is also a possibility to use multiple excitations (shakers) in free-run mode. E.g. the shakers are sweeping with the 
same frequency, but with a phase difference.

Let's assume the structure is excited by two shakers at the points 3 and 4. The response accelerometers are mounted in 
the points 1 and 2.

DEWESoft will create transfer functions from each point to each excitation (MIMO = Multiple Input Multiple Output), 
as shown in the channel list below.
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3.2.4 ODS

In ODS analysis (= operational deflection shapes) the structure is only excited by the machine, like in real operation, 
whenever it is not possible to vary the excitation frequency. There are only accelerometers used.

Inside DEWESoft FRF module one of the acceleration sensors has to be defined as excitation (this one is the reference, 
normalized to 1), the others as response. Animation can be displayed as usual, but only makes sense in areas with good 
coherence.

Page 24/49 Doc-Version: 1.0

         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™

        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation   

Exc

Resp

www.chinaksi.com

http://www.dewesoft.com/
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4 Measurement and visualisation

4.1 Auto-generated displays
For an easier start DEWESoft offers auto-generated displays, which already come with the most often used instruments 
and an arrangement that makes sense for the according type of application.

With the FRF option and 1 module added, usually when switching to measure mode, there should already appear a 
screen with a small toothwheel, called “Modal Test”.

If that is not the case, please go to Settings → Project setup... → Displays → and enable the “Automatically generate 
displays” checkbox. Then add a new FRF module. - With triggered setup (modal hammer), the screen should look like 
this:

The excitation and response sections each consist of two 2D graph instruments (scope and FFT) showing array data of 
hammer (red) and accelerometer signal (blue). The Info channel will show the current point or events such as double-
hit. The Control buttons are used for going from one point to the next, or cancelling and repeating a point if the result 
was not satisfying. The OVL display shows if the impact or response signals are too high, exceeding the physical input 
range of the amplifier. The FRF Geometry is already animated in the current point during measurement. Two further 2D
graphs on the right side show transfer function and coherence.

All these instruments / parameters are described on the following pages.
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4.2 FRF info channels
There are additional channels provided by the FRF module, which give status information during the measurement. To 
display them, please add an indicator lamp in design mode:

Then set it to “Discrete display” mode (picture below, left).

The channels “Info” and “OVLChannel” can be assigned to it. OVLChannel will only be displayed if the according 
option has been enabled first (see also page 9, chapter 3.1 Triggered).

4.3 FRF control channels
During triggered measurement, after one point is finished, you can continue by pressing the “Next point” 
button.

If you are unsatisfied with the last hit, you can cancel it by using “Reject last”.

If all hits for the whole point are incorrect, e.g. if you hit on a point with a wrong number, with “Reset point” 
you can delete all the hits done for the current point at once.

All the actions are done using “control channels” in DEWESoft. These can be modified during measurement. To change
it manually, you need to pick the “input control display” from the intrument toolbar. Set it to Control Channel and Push 
button. Channels “Reject last”, “Next point” and “Reset point” can now be assigned from the channel list on the right.

When you exit the design mode, you are able to press the buttons.

Page 26/49 Doc-Version: 1.0

         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™         DEWESoft™

        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation        measurement innovation   

www.chinaksi.com

http://www.dewesoft.com/


Measurement and visualisation

4.4 Geometry editor
In DEWESoft you can quickly draw simple structures, as well as import more complex ones. Cartesian and cylindrical 
coordinate system is supported, which is great for drawing circular objects.

IMPORTANT
The Index numbers defined in the channel setup before are used as Point numbers in the 
geometry for animation.

In Design mode we add the “FRF Geometry” instrument. Then you can either load a UNV (universal file format) 
geometry file, or create your own.

4.4.1 Importing a structure
There are two ways of importing a UNV / UFF (universal file format) geometry of other software (e.g. MEScope or 
Femap) into DEWESoft. Of course you can also import a geometry drawn in DEWESoft FRF Editor before. We support
the newer “2411” format, if you experience troubles, please contact our support for the older plugin version supporting 
the outdated “15” format.

From the properties of the FRF geometry instrument on the left select “Load UNV”, or go to the Editor and do it there.
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4.4.2 Drawing a structure
We will now use the editor to create a simple quadratic shape.

Cartesian Coordinates

At first you can chose between Cartesian or Cylindrical coordinate system (see the two buttons below). Cartesian is 
default, so just add points with the “+” button, then enter coordinates. Keep in mind that the excitation direction was 
defined in FRF channel setup before (in our examples Z+), therefore Z is up, the hammer hits from top down.
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You can define nodes (=points), then add trace lines between them by selecting from the pop-up...

… and use Triangles or Quads to optimize visualisation. Then save the structure.

Cylindrical Coordinates

And here is an example how to create a cylindrical structure using the cylindrical coordinate system. You have to 
specify the Center point CS, radius R, angle theta T, and height Z.

Cartesian and cylindrical CS can be combined in one geometry.
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5 Analyse and export

5.1 Transfer function
For the following explanation of parameters a triggered FRF was done on a snowboard structure. All 39 excitation 
points were sequentially hit by the modal hammer and related to 1 accelerometer placed in the center.

Only 1 hammer and 1 sensor was used! (please refer to page 23, chapter 3.2.3 Free run, FGEN, multiple shakers if 
using multiple excitations/shakers).

From the channel list on the right side, we see that each point (#1, #2, #3, …) is related to the reference point (#20). For 
each excitation point a transfer function was calculated, e.g. TF_20Z+/1Z+.

Transfer functions consist of amplitude/phase or real/imaginary part. The 2D graph is the instrument to use, there you 
can select what you want to display by using the properties from the left side.

    

To make a bode plot, use two 2D graphs below each other. The above one shows the amplitude (y axis type: LOG), the 
lower one the phase (y axis type: LIN).

When the amplitude of the transfer function shows a local maximum, and the phase is turning in this point, it usually 
indicates a resonance. But to avoid an errorneous statement, other parameters have to be checked as well!
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5.2 Coherence
The coherence is used to check the correlation between output spectrum and input spectrum. So you can estimate the 
power transfer between input and output of a linear system. Easily talking, it shows how good the input and output are 
related to each other.

The amplitude of the coherence can reach max 1.

Low values indicate a weak relation (e.g. when the excitation spectrum has gaps at certain frequencies), values close to 
1 show a representative measurement.

That means, when the transfer function shows a peak, but the coherence is low (red circles in the picture below), it must
not necessarily be a real resonance. Maybe the measurement has to be repeated (e.g. with different hammer tip?), or you
can additionally look for the MIF parameter, explained below.

Coherence is a Vector channel, and therefore displayed with a 2D graph instrument.

The coherence is calculated seperately for each point (e.g. Coherence_3Z/1Z, Coherence_4Z/1Z, …).

5.3 Mode Indicator Function (MIF)
If all parts of a structure are moving sinusoidally with the same frequency (fixed phase relations), this motion is called 
normal mode. This happens at resonance, or natural frequencies. Depending on the structure, material and bounding 
conditions there exist a number of mode shapes (e.g. twisting, bending, half-period, full-period movement...). 

These are usually found out by finite elements simulation software, or by experimental measurement and analysis.

When the amplitude of the transfer function shows a local maximum, and the phase is turning in this point, it usually 
indicates a resonance. To be sure, also the Coherence should be checked, as described before. And last, you can look for
the MIF (=Mode Indicator Function).

A MIF close to 1 indicates a mode shape.

The spikes shown in the picture below are very likely resonance frequencies. Just click on them and check the 
movement in the geometry instrument.

MIF is a Vector channel, and therefore also displayed with a 2D graph instrument.

The MIF is calculated over all transfer functions (all points), therefore is only one channel.
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5.4 FRF animation
The FRF animation is done by putting sine functions with the amplitudes and phases from the measurement into the 
geometry model points. The animation is done in one direction (in our example Z+). You can animate the structure for a
single frequency, which can be chosen in the 2D graph, when setting the Cursor type to “Channel cursor”, as shown 
below. All FRF instruments will follow the channel cursor.

Other than that, the frequency can also be chosen by entering it manually in the FRF geometry properties on the left.

Different parameters like animation speed and amplitude (scale), as well as the visibilty (nodes, point numbers, traces, 
shapes, coordinate system axes) can be changed here.

Here are some of the mode shapes of the snowboard calculated by DEWESoft FRF (you nicely can see bending and 
twisting).
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5.5 Modal circle
Finally, when you are certain the point you are looking at is a resonance, you might want to get it's exact frequency and 
damping factor. As the FFT can never be that precise (high line resolution needs long calculation time, which is not 
given when there is a hammer impact), there are some mathematical methods to interpolate.

The method DEWESoft is using, is based on the well-known circle-fit principle. The FFT lines to the right and left side 
of a peak (so called “neighbour lines”) are drawn by real and imaginary part in the complex coordinate system. A circle 
is aligned between them with minium error to each point and the resonance frequency is approximated.

In the example below we switched the 2D graph “Graph type” property to “histogram” to make the FFT lines visible.

Imagine, we had a sample rate of 2000 Hz, and 1024 FFT lines, resulting in a line resolution of 0.977 Hz. The peak we 
are looking at is 73,2 Hz. But it could be in the range of 73,2 Hz +/- 0,977 Hz.

We add the Modal circle from the instrument toolbar (see picture above). The 2D graph is again in “cursor” mode, the 
modal circle instrument will follow. – By clicking on the peak, at first no resonance peak is found.

Then we increase the “Peak search” range from 10 Hz to 20 Hz. The peak is found and by changing the neighbour count
you can select how many FFT lines left and right from the peak are taken into calculation. The points should all be 
aligned nicely on a circle. The red dot shows the calculation result, which should be near the center.

 

Our final result shows 72,775 Hz and a damping factor of 0,038. With these parameters one can proceed further in 
simulation software.
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5.6 Export of complex data
After the measurement is done the data can be exported to a lot of different file formats, e.g. UNV/UFF, Diadem, 
Matlab, Excel, Text... The transfer functions (as shown on page 31, chapter 5.1 Transfer function) can be seperately 
exported by Real, Imag, Ampl or Phase part, whatever you prefer.

In MS Excel for example the transfer function data will appear on a sheet called “Single value”. For each transfer 
function Real/Imag/Ampl/Phase is exported.

HINT
If you prefer it differently, data rows and columns can simply be exchanged in MS Excel by 
copying and using the “Transpose” function from the submenu when pasting.
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5.7 Export in UNV / UFF format
The Universal File Format (also known as UFF or UNV fomat) is very common in modal analysis. Depending on the 
header it can contain either transfer functions, coherence, geometry, ... or various other data.

The following example shows how to export data recorded by DEWESoft into Vibrant Technologies ME Scope 
analysis software and how to display it there.

1. At first chose the “Universal file format” from the export section and select all your transfer functions (you can
use the Filter and type “TF” for simplification). It does not matter if you select Real/Imag/Ampl/Phase part, as 
the UFF/UNV export follows the standard. This will create a UNV datafile.

2. In FRF geometry editor save the structure also in UNV format. This creates the UNV geometry file.

3. Start ME Scope and click File → Import → Data block. Select the UNV datafile. The transfer functions are 
already recognized.
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4. Then click File → Import → Structure and select the UNV geometry file.

5. Now both data and geometry are successfully imported. Let's try to animate it, select Draw → Animate Shapes.

A pop up appears, and we select to match structure and transfer data. Equations are created.

      

6. Finally you can select a peak on a transfer function and enjoy the animation.
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6 Examples (step-by-step)

6.1 Triggered (roving hammer)
As the triggered measurement might be difficult to understand, this section shows how to use the mentioned controls 
and tools step-by-step. The setup will be done according to page 16, chapter 3.1.2 Triggered, roving hammer.

Let's say we want to analyze this metal sheet structure. At first we define the direction of analysis (orientation up/down, 
Z axis), then we put it on a soft rubber foam that it can vibrate freely. Of course hanging it with rubber bands from the 
roof would be better, but would also take more time to wait in each point until the ringing fades out; for now we are fine
with it.

Then mark equidistant points, in our case from #1 to #24. The higher the number of points, the more detailed the 
animation will be. It is also helpful to write numbers next to the points. They should be consistent on 1. structure, in 2. 
channel setup and 3. FRF geometry in software.

The hammer will move through the points, so in one point an accelerometer has to be mounted. We select point #12.

1. We define the sampling rate with 5000 Hz. Name the hammer and accelerometer in the channel setup and 
apply the scaling. In our case both are of IEPE type, hammer is measuring force in N, accelerometer 
acceleration in g. Then go into the channel setup of the hammer.
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2. Do a test impact with the hammer on the structure. In the scope preview memorize the max value.

3. In Modal test setup chose the Triggered FRF type, and use “roving hammer” option. The trigger level should 
be set somewhere below the max value of the the pre-measurement just done, e.g. 1 N. We will do 3 hits in 
each point, which are then averaged. The FFT window size is 2048, which gives a good line resolution of 1.22 
Hz. - Note, that point #12 is missing on the left side, it will not be hit during measurement, because the 
accelerometer is mounted there.
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4. Now that the points are defined, it is time for drawing the structure. When you switch to measure mode, 
usually you should have an auto-generated screen called “Modal test”. There the FRF geometry instrument is 
already shown (x,y,z axis display). From the left side (properties) select “Editor” and add 24 points and their 
coordinates. You can draw trace lines between them and finally quads (shapes) between them. - Take care, that 
the excitation direction Z is upright and should have the same level for all points of this structure.

5. Now it's time for a test hit, and finalizing the display arrangement. In measure mode – without storing – you 
can do a test hit, to fill the displays with signals. Immediately the structure will be animated in the first point. If
the auto-generated screen does not look like below, you might have to assign the channels to the instruments. 
The idea is showing the excitation (blue box) on the left and response (red box) on the right. Use the Scope and
FFT signals of the “Current point” subsection in the channel list. They are marked red, because only available 
during measurement. - On the two displays in the lower right section you could use TF and Coherence.
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6. To be absolutely sure that your sampling rate and FFT lines settings are correct, you can add two 2D graphs 
and show the “hammer/Data History” and “acc/Data History”. This is the window used for calculation. Your 
whole signals should be covered. If the structure keeps on ringing and the response signal is cut, increase the 
window length (use a higher line resolution or lower sampling rate) or select a lower value for the “Response 
window decay” parameter. Unfortunately the windowed signals currently cannot be shown.

7. Now we are ready for the measurement. Start storing and do 3 hits on point #1. The scope and FFT graphs will 
be updated after each hit, so you can visually check for double-hits or “bad” hits and reject them. If you hit a 
wrong point, you can also reset the whole point. After clicking the “Next point” button, the point number 
increases, always showing you the current transfer function (e.g. 12-1, 12-2, …).

. . . 

The procedure can also be described by a flow chart:
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8. When finished, go to Analyze mode. Automatically the last stored file is reloaded. Now you might want to 
modify the screen for further investigation.

The screen below gives an idea. It shows the first four transfer functions (TF12-1, 12-2, 12-3, 12-4) with 
amplitude and phase. Below the MIF is shown for easily finding the mode shapes. Just click on the peaks (with
the instrument set to Channel cursor mode), on the lower right side the modal circle calculates the exact 
frequency and damping.

Here are some of the mode shapes animated.
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6.2 Free-run
This is a practical example showing free-run FRF. The Analog out of the SIRIUS instrument (FGEN) is followed by an 
audio amplifier which drives a loudspeaker. On the membran a metal structure (metal beam) is mounted with a force 
transducer (excitation) and two acceleration sensors (responses).

1. In the Analog section we define our force sensor and the two accelerometers. They are all of type IEPE. As we 
want to analyze our structure up to 1000 Hz, we select a sampling rate of e.g. 5000 Hz.

2. Next we add a FRF module and chose “Use function generator”. A window size of 1024 lines results in a nice 
resolution of 2.44 Hz. We select a sine sweep from 1 to 1000 Hz. The index numbers 1, 2 and 3 are entered 
according to the structure, direction is Z+ for all.
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3. Also check the Analog out section. Start and stop frequency are already overtaken from the FRF module. We 
adjust the sweep time (120 seconds) and amplitude (1 V) for now. Startup time and fall time is 0.1 s by default,
which prohibits sudden crackles, that could result in wide-spectrum noise at beginning and end of 
measurement.

4. Now we are ready for drawing the structure. Go to measure mode, the screen “Modal test” should be auto-
generated. Click on the FRF geometry instrument and select “Editor” from the left side. Then add 3 points with
the + button, example coordinates as shown below. Then save the structure by clicking on File → Save UNV...
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5. Now we are ready for measurement. When you click the store button, the FGEN will start, the AO will sweep 
from 1 to 1000 Hz. The transfer functions will smoothen from left to right side, here you see a snapshot 
currently at 357 Hz.

6. Finally we can look at the result. The coherence of both channels related to the excitation looks very nice. The 
green line (MIF) indicates mode shapes, click on the peaks and the structure will be animated.
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FAQ

7 FAQ

Problem: FRF Geometry instrument cannot be found in the instrument toolbar in Design mode.

Solution: This is a plugin which needs to be registered. Check first if the file “FRFGeometry.vc” is present in your 
Dewesoft Addons folder (e.g. D:\DEWESoft7\Bin\V7_1\Addons). Then start DEWESoft and go to Settings → 
Hardware Setup → Plugins and click → Register plugins. You need administrator rights to do that. Please contact your 
local IT administrator.

Problem: Coherence for higher frequencies too low (appears noisy).

Solution: Please check impact signal FFT spectrum. If using a hammer with a soft tip, the excitation spectrum is 
usually small (high damping). Try again with a harder tip.
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Documentation version history

8 Documentation version history
Revision number: 310
Last modified: Thu 29 May 2014, 13:13

Version
Date

[dd.mm.yyyy] Notes

1.0 29.05.14 ☑ initial revision
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